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By the time you receive this edition of 
Railway Photography Christmas will be 

over and New Year celebrations are about 
to be held. In terms of railways, in the UK 
and overseas, 2007 is sure to bring with 
it more surprises and opportunities for 
photography.
    In the UK a number of changes are 
just around the corner, in terms of rolling 
stock deployment and indeed operators of 
franchises. All of which are sure to generate 
some interesting illustrations.
    In the pages of Railway Photography 
we try and bring readers the very best in 
traditional pictures as well as some form of 
guidance to the ever growing and complex 
world of digital imagery. I am often asked 
‘how do I do this or that’ in terms of 
photographic editing and throughout 2007 
we will continue to look at some of the 
editing and image modification methods 
now available. 

    However I will emphasise again as I 
have in the past, while editing and altering 
images is fine for home use, or display on 
your office wall or computer screen, the era 
of digital images could in the wrong hands 
have a serious effect on long term railway 
history, and this must not be allowed to 
happen. Recently I had to turn down a 
couple of pictures where the photographer 
had changed the loco numbers, removed 
features from locomotives and even 
removed buildings from the city scape. 
Fine, if this is for your own consumption, 
but no if we are going to publish the work 
as a record of an event or locomotive.
     Please be careful when editing to tell 
editors what you have done.
    I wish all readers a prosperous New Year 
and I hope you will continue to enjoy RP.

 Colin J. Marsden
Editor  
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The publishers of Railway Photography 
- TheRailwayCentre.Com Ltd - welcome 
submissions for inclusion. 
   We are looking for high resolution, 
good clear, but above all sharp images 
of any railway subject. Submissions 
should be sent by email in the .jpg 
format to rp@therailwaycentre.com 
please make sure that attachments are 
no larger than 6mb. We are happy to 
receive high-quality scans of negatives 
and slides. With all submissions please 
make sure you include your name and 
full details about the picture, including 
camera and exposure details.    
    As Railway Photography is distributed 
free of charge, we are unable to offer 
reproduction fees.
    We are happy to consider small 
editorial features on aspects of railway 
photography.

Editor: Colin J. Marsden
Design: TRC Publishing
Railway Photography is published by 
TheRailwayCentre.Com Ltd
PO Box 45
Dawlish, Devon
EX7 9XY
Tel: 01626 862320
E.Mail: rp@therailwaycentre.com

Page 3 illustration: Preserved Class 31/1 No. 31108 stands at Swanwick Junction as frost starts to form in the 
moonlight on 9 December 2006. The photographer records that “I shot with a short and wide exposure to minimise 
the moon’s movement and to minimise flare. This was difficult lighting - a combination of tungsten lights at about 
2,500K and the moon at much more.  Shot Raw, processed in Nikon Capture 4.4, and tweaked in Photoshop CS 
- layer masks for Levels, Curves, Saturation and to sort the different colour temperatures”. Mike Mccormack 
Photographic details: Camera: Nikon D2X, Lens: Nikon 28-70mm zoom at 42mm, ISO: 250, 
Exposure: 3.6sec @ f4

Above: The preserved Class 50s which are authorised for main line use still attract a huge following. Nos. 50031 
and 50049 are seen near Eldroth on the Lancaster to Settle line while employed on the 1Z50 Cardiff to Leeds ‘Airean 
Raider’ tour on 16 December 2006. Nigel Cockburn
Photographic details: Camera: Canon EOS20D, Lens: Sigma 24-70 zoom at 32mm, ISO: 200, 
Exposure: 1/500sec @ f7.1
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Something which is not everyday photography is the art of special 
effects. These are generated in the electronic darkroom and may 

involve the use of filters within your editing software, the joining 
together of two images or part editing an illustration.
    In the main these special effect or artistic interpretations of pictures 
have no place in general photography and would not be welcome in 
the printed media, however, if you are one of the growing number 
of digital photographers who have use of an electronic projector and 
can play film shows generated on your computer to an audience, then 
these special effect images are very useful for title, intermission and 
end images, or can be used to split up a show into sections.
    The majority of photo editing packages have the ability to generate a 
slide show and you as the operator would have the say in which order 
the pictures are shown, much in the same way as a traditional 35mm 
or large format film slide show.
    Over the years I have found that while you can write an overlay 
to a standard picture for the start and other points of your show, it 
is usually better to make the image into a special effect, it attracts 
the attention of the audience and while obviously showing what the 
subject is, the attention is drawn to the text.
    In Photoshop CS, you need to select an image which generally has 
an amount of space around the subject, sky, fields, water or the like. 

Special effect pictures
Before you add your text, you can styalise the image. A number of 
built in filters are supplied with Photoshop and can be accessed from 
the  filter menu. The two images on this page and the one at the top of 
the following page were generated by selecting the Filter>Blur>Radial 
Blur option, you are then given a box in which you can direct the centre 
of your ‘blur’ effect, the strength of the blur is controlled by the slider, 
these images are generated with a level of 14. You will also need to 
select the ‘zoom method’ and ‘best quality’.
    It is worth have an experiment before you make your final edit, but 
please remember to only work on a copy of the original file, as once you 
have made these filter changes you cannot reverse the procedure.
    Once you are happy with the special effect you are ready to add your 
text. This I usually do in a simple font so it is easily readable from any 
distance and select a colour to contrast with the background. By using 
the text tool ‘T’ from the Photoshop menu and clicking on the image 
you can type away. Then by selecting the copy you can edit the font, its 
size and colour in the usual way. You can also by using the ‘move tool’ 
adjust the position of the text to suit your image. Once you have the 
correct position, go to the Layer menu and select ‘Flatten Image, this 
will place all the text and illustration on one level, making the text part 
of the original picture. 

CJM

Left: Two samples of how a special effect 
image can be made to act as a start up for a 
slide show. The picture while obvious in terms 
of subject and even its location, centres the 
eye on the text. In this case the text selected 
was applied in 50 point and after flattening 
and re-sizing the image it is still readable. In 
the upper picture of the Voyager, the centre of 
the ‘Radial Blur’ was applied to the headlight, 
making the front of the train sharp, with the 
background fading away. In the lower picture, 
the centre of the ‘Radial Blur’ was the number 
on the cab side of the leading locomotive.
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Right: The image here of the front end of a BNSF ES44DC was also 
generated in the same way using the ‘Radial Blur’ tool. The centre 
of the blur was the headlight on the centre of the front end, which 
also gives a ‘speed’ effect. In the mid-blue sky area little distortation 
is recorded and the text for your page or slide show can easily be 
applied.
All pictures: Colin J. Marsden

Sometimes the required special effect can only be obtained 
by joining together two images. In the sample below this 

was done to produce a Christmas card . The main image of 
the Voyager traversing the sea wall at Dawlish was taken 
especially with a lot of space on the right side. Firstly this 
enabled some text in a contrasting colour to be applied in the 
same way as detailed on the previous page. Then the aircraft 
was added. This was taken from another image taken during 
an air display and was a close up picture. The first thing to do 
was reduce this image to the required size, in this case 1200 
pixels. The next stage was to use the ‘Magic Wand’ tool and 
click in the sky area. Then go to the Select menu and choose 
Select>Inverse, this will give you the main subject of the 
image as the selection, once this is done go to Edit>Copy, this 
will move the aircraft image into the computer memory. Now 
reopen the main picture and paste the aircraft onto the image. 
By using the ‘Move Tool’ you can then position your aircraft 
where you want it in the main picture. When you are happy 
with the position go to the Layers Menu and select ‘Flatten 
Image’, your combined picture will now be one.

n One word of warning - Please do not try and pass off 
such altered pictures for publication, these are clever to do 
and excellent for personal or show use, but not good for 
publication.
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Above: EWS Class 66/0 No. 66094 passes through Halifax on 7 August 2006 powering train 6G99, the 16.29 MWO Laisterdyke to Healey Mills scrap train. 
This was the only freight train through this once busy freight centre on this day. The careful positioning of the train in the landscape is as good as one could ever 
get, with the train neatly in front of the terraced houses but not visually clashing, while the tree on the right forms a frame. The fact that no cars were in the car 
park helps by not having extraneous colour to detract the eye from the main picture. David Rodgers
Photographic details: Canon 10D, Lens: Canon 24-85mm zoom at 24mm, ISO: 100, Exposure: 1/320 @ f6.3  

Left: With only four EWS Class 37s 
now in daily traffic, and all allocated 
to Scotland, this winter might well see 
some English Electric ‘thrash’ north of 
the boarder. No. 37406 is shown heading 
west with Linlithgow as the backdrop 
along the Edinburgh-Glasgow main 
line with a diverted 6A30 Mossend to 
Aberdeen working on 22 September 2006. 
The photographer remarks “that on this 
day the train was very long, and made 
a fantastic sight and sound!” The train 
consisted of 12 empty calcium carbonate 
tanks, and 15 loaded bogie pipe wagons.
James Young   
Photographic details: Canon 
EOS350D, Lens: Canon 18-55mm 
zoom at 39mm, ISO: 200, Exposure: 
1/1000 @ f6.3 

Railway PictorialRailway Pictorial Railway Photography looks forward to receiving your 
pictures for inclusion in these pages, please send 

high-resolution images to RP@therailwaycentre.com and 
share your work with others.
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Above: Trans Rail Class DX Nos. 5016, 5051, 5022 and Class DC No. 4225 pass MacKay’s crossing between Paekakariki and Paraparaumu in New Zealand 
and head north onto the single track with Train No. 238 from Wellington to Auckland on Sunday 17 September 2006. A notorious local bottleneck will soon be a 
thing of the past when a new rail overbridge in the background is completed. Alan Wickens 
Photographic details: Sony DSC-F828, ISO: 100, Exposure: 1/1000 @ f4.5

Below: In the period of transition between diesel and electric traction on the East Coast Main Line, scenes such as this at Bounds Green depot in North London 
were common. On 6 August 1988, Railfreight ‘red stripe’ Class 31/1 No. 31135 shunts three brand new Class 91s into storage sidings at the depot, prior to 
introduction into passenger service. Thankfully over the years many photographers with access to such depots and facilities have recorded these rare and unusual 
workings. Charlie Robbins
Photographic details: Camera: Minolta X700, Lens: Minolta standard 50mm f1.7, Scanned Film, Exposure: 1/125 @ f5
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Below: A recent ballast train working in the Melbourne area of Australia is recorded using three locomotives with a combined working life of over 136 years! 
First up the oldest, EMD B76 from 1953, recently overhauled and repainted into CFCLA colours (Chicago Freight Car Leasing Australia), formerly part of the 
West Coast Railway fleet of  bulldogs and Victorian Railways before that. Second comes CFCLA 44s1, formerly South Australian Railway Alco 961 from 1965 
and finally CFCLA T385 of 1964, formerly of the West Coast Railway fleet and  before that Victorian Railways. The train is laying ballast by remote control (of 
the hoppers, not locomotives) to the west of Melbourne at Hoppers Crossing on 14 November 2006. Melbourne can be seen in the background.  Chris Nuthall
Photographic details: Camera: Pentax istD, Lens: Pentax zoom at 88mm, ISO: 400, Exposure: 1/750 @ f11

Above: Eurostar sets operating over the Channel Tunnel Rail Link or High Speed 1 (HS1 in the UK are always impressive, especially when travelling at a full 
300km/h (300mph). On 12 May 2006, French-owned sets Nos. 373206/05 branded Fete l’Europe pass kilometer post 81 at Charing, Kent while forming train 
No. 9027, the 12.19 Paris Nord to Waterloo International. When photographing these services on HS1, a high shutter speed is always needed to ensure the image 
is totally sharp. A speed of at least 1/2000 is recommended, but 1/1000 will hopefully freeze the movement if a slight pan is performed.  Brian Stephenson
Photographic details: Camera: Nikon D200, Lens: Nikon 17-55mm zoom at 40mm, ISO: 250, Exposure: 1/1250 @ f5
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Above: In May 2006 French-owned Eurostar sets Nos. 373209/10 were outshopped in full advertising livery for the world premier of the film ‘The de Vinci Code’, 
which was held as part of the Cannes Film Festival. The set was used to form the longest ever non-stop passenger train which travelled from Waterloo International 
non stop to Cannes in the South of France. Here the special train, carrying dozens of actors and actresses who were in the film, plus supporting stars and film makers 
pass kilometer post 84 at Tutt Hill, near Hothfield, Kent on its non-stop run to Cannes on Tuesday 16 May 2006. Brian Stephenson
Photographic details: Camera: Nikon D200, Lens: Nikon 17-55mm zoom at 48mm, ISO: 400, Exposure: 1/1600 @ f4.5

Below: Pacific National Co-Co diesel-electrics Nos. NR69, NR85 and NR64 pass Werai in New South Wales, Australia on 30 September 2006 powering train 
7SP3 the Sydney to Perth superfreighter. The bright but misty conditions have focused the eye on the main subject, with the background trees being in suitable relief.  
The choice of taking standpoint at this location is just right, lined up with the viewpoint of the train pulling off the long straight and bearing round the curve. The 
trackside hut adds to the composition, which is also helped by the loco exhaust. These locos were built by Goninan at Bassendean in 1996-97 and are fitted with a 
General Electric 7FDL-16 power unit and develop up to 4,020hp. Chris Walters
Photographic details: Camera: Pentax *ist DL, Lens: Pentax zoom at 78mm, ISO: 200, Exposure: 1/1000 @ f5.6
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Above: The wonderful winter lighting, compounded by some cold pre-Christmas weather generated some excellent smoke scenes on the light railways and National 
Network. On the Mid Hants Railway near Ropley, BR Standard 5 No. 73096 powers a six-coach formation on 16 December 2006 and provides an amazing smoke 
display. Chris Holt
Photographic details: Camera: Canon EOS30D, Lens: Canon zoom at 50mm, ISO: 250, Exposure: 1/1600 @ F5

Below: On both 21 and 22 December 2006 Vintage Trains operated a circular ‘Luncheon Tour’ from Dorridge via Solihull and Tyseley. Motive power was provided 
by ex-GWR ‘Hall’ No. 4965 Rood Ashton Hall which is shown just coming to a standstill at Dorridge. The photographer said he “had to be quick before the hi-
vis jackets made an appearance” The presence of the smoke in front of the stark white platform lighting makes an eerie almost timeless picture with the only other 
illumination provided by the high power headlight shinning through the mist and smoke. Clive Hanley
Photographic details: Camera: Nikon D50, Lens: Nikon zoom at 26mm, ISO: 400, Exposure: 1/1/1.6sec @ F4.2
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Above: Railway photography comes in a number of types, record illustrations, detail pictures, pictorial work and of course ‘new approach’ or  progressive work. All 
have their specific need, a record illustration such as this of EWS/grey-liveried Class 60 No. 60092 hauling a long rake of Lime stone covered hoppers out of Thornaby 
Marshalling Yard on 30 September 2006 is very welcome by modellers and those interested in recording locomotive details. Frequently photographers tend these days 
to go for a more scenic view and when the need arises close up pictures are hard to find in such good quality. James Stoker
Photographic details: Camera: Fuji Finepix S5600, ISO: 64, Exposure: 1/580 @ f3.6

Below: In the period when EWS class 90s and loco hauled stock operated the ScotRail Edinburgh - North Berwick route some unusual pictures of loco hauled branch 
line services were possible. EWS-liveried No. 90037 passes Spittal near Edinburgh powering the 12.17 North Berwick to Edinburgh service on 22 July 2005. The
photographer has positioned the train to perfection not clashing with the overhead power lines front or rear, while including very pleasant scenery in the picture. 
Mark Bearton
Photographic details: Camera: Canon EOS300D, Lens: Canon zoom at 190mm, ISO: 200, Exposure: 1/1000 @ f6.3
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Above: Built by Alstom between 1969 and 1974, the 74 members of the CC 6500 class were some of the most popular electrics to have operated in France. Sadly 
the fleet were withdrawn from service in 2006. On 2 September 2003, No. CC6507 passes St Jean de la Porte on the Modane-Chambery route with a southbound, 
mixed freight. Colin J. Marsden
Photographic details: Camera: Nikon D1X, Lens: Nikon 35-70 zoom at 44mm, ISO: 250, Exposure:  1/1000@ f5

Below: Painted in the distinctive grey, maroon and orange livery, the 1,500V dc locos were used on a mix of passenger and freight services with a top speed of 
200km/h, but in later years when the class were confined to freight service the speed was reduced to 100-160km/h. No. CC6531 is seen near St Jean de la Porte, on 
5 September 2003 with a northbound ammonia tank train bound for the Italian border at Modane. Colin J. Marsden
Photographic details: Camera: Nikon D1X, Lens: Nikon 35-70 zoom at 35mm, ISO: 800, Exposure:  1/1000@ f4.5

SNCF CC 6500 class electricsSNCF CC 6500 class electrics
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Above: With the split of the French Railways into business sectors and the formation of Fret SNCF, the CC6500s became part of that operation. The freight 
classification ‘40’ was added as a prefix to the running number and several were repainted into Fret-SNCF green and white livery. No. 406557 is shown on 3 
September 2003 powering a northbound mixed freight near Argintine, on the Chambery-Modane route. Colin J. Marsden
Photographic details: Camera: Nikon D1X, Lens: Nikon 35-70 zoom at 35mm, ISO: 400, Exposure:  1/1000@ f7.1

Below: CC6522 approaches the station at Virieu le Grand/Belley, on the section of line between Amberiue and Chambery on 1 September 2003 powering a short 
mixed freight. This freight had previously been seen in the yards at Amberiue  and eventually headed for the Italian border. Colin J. Marsden 
Photographic details: Camera: Nikon D1X, Lens: Nikon 35-70 zoom at 40mm, ISO: 400, Exposure:  1/1000@ f6.3



Railway Photography14

The World in MonochromeThe World in Monochrome

Above: Workshop and construction pictures have always been of considerable interest to the editor of Railway Photography. In this view the basic shell of 
Class 60 No. 60005 takes shape at Procor Engineering of Horbury Junction, Wakefield on 25 April 1989. All Class 60 body shells were fabricated in this building 
and then taken by road to Brush Traction at Loughborough for fitting out. Colin J. Marsden
Photographic details: Camera: Nikon FM2, Lens: Nikon 35mm f1.4, Film: Ilford XP2 at 400ASA, Exposure: 1/30sec @ f8. Negative scanned on 
Nikon Coolscan9000 at 500dpi.

Below: For a period in 1984 a new aluminium bogie hopper wagon and eventually a fleet, were trialed by Foster Yeoman for the movement of aggregates from the 
Mendips to the Home Counties. Sadly the design had a number of structural flaws and all were quickly withdrawn and broken up. One of the type is seen behind 
Class 56 No. 56044 approaching Fairwood Junction, Westbury on 31 August 1984 forming the 16.15 Merehead-Acton service. Colin J. Marsden
Photographic details: Camera: Pentax 6x7, Lens: Pentax 200mm f2.4, Film: Kodak TriX at 400ASA, Exposure: 1/500sec @ f6.3. Negative scanned 
on Nikon Coolscan9000 at 500dpi.
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Above: Taken in the ‘Fall’ (Autumn) of 2003 at Bernardsville near the end of the Hoboken to Gladstone branch in New York, USA, this three-car electric 
multiple unit comprises of ‘Silver Arrow’  11kV 25Hz units, then recently refurbished and equipped with thyristor control by the American branch of Brown 
Boveri. Note the NJ (New Jersey) Transit logo on the front end. Arthur Tayler
Photographic details: Not supplied

Below: A view of the Royal Albert Bridge linking Devon with Cornwall that cannot be repeated, the train, a Class 155, has been rebuilt as single car Class 153s, a 
huge tree has now grown and blocked the foreground view and the inspection frame removed from the bridge in front of Isambard Kingdom Brunel’s name. Class 155 
No. 155303 carrying its original ‘Sprinter’ bodyside legend, arrives in Devon on 30 June 1988 forming the  09.20 Penzance-Plymouth. Colin J. Marsden
Photographic details: Camera: Nikon FM2, Lens: Nikon 50mm f1.4, Film: Ilford XP2 at 400ASA, Exposure: 1/500sec @ f3.5. Negative scanned on 
Nikon Coolscan9000 at 500dpi.
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Above: The foggy weather of December 
2006 in the UK caused a lot of travel 
problems for air and road transport, 
while the railways managed to operate 
to normal timetables. The weather 
did however allow some of the more 
adventurous photographers to use the 
fog to good advantage. Here an ‘up’ 
HST passes Class 60 No. 60052 at West 
Drayton on 22 December 2006 working 
a Colnbrook-Lindsey service. The image 
was taken at 1/1000 at f2.8 at 800 ISO 
in raw format on a Canon EOS 5D with 
a Canon 50mm f1.8 lens. The image 
file was processed in Canon DPP Raw 
converter with two conversions combined 
using Photomatix ‘Highlight & Shadow’ 
option to improve the clarity of the station 
lights. Then given small colour balance 
and brightness adjustments plus cropping 
in Photoshop. Kim Fullbrook

Middle Left: Captioned by the 
photographer as “A wet Virgin at 
Reading” it shows that the presence of 
rail in a railway illustration is not always 
a bad thing. On 17 November 2006, a 
Class 220 ‘Voyager’ is seen through a 
cloudburst awaiting to depart with the 
09.35 service to Manchester Piccadilly. 
The use of a slow shutter speed on such 
images helps to accentuate the rain and 
makes a blur as it falls. A higher shutter 
speed would have not produced such an 
effective result. Simon Jeffs
Photographic details: Camera: Fuji 
Finepix F11, ISO: 400, Exposure:  
1/75@ f3.4

The weather is in control

Rail Photoprints 2007 Calendars
For those who are interested in high quality 
railway photography, the Rail Photoprints 2007 
calendars are still available. Two calendars are 
published, one covering Modern Traction and the 
other Steam. Each contains  16 very high quality 
illustrations from the top photographers. 

Calendars can be obtained at £6.40 each including 
post and packing from:

Rail Photoprints, 8 Paulmont Rise, Temple Cloud, 
Near Bristol. BS39 5DT



From a different viewpoint........From a different viewpoint........

Right: Not every railway picture needs to include a train, as 
demonstrated here by this wonderful pair of brass made, but 
electrically operated loco lamps on the Furka Mountain Steam 
Railway in Switzerland.  Our photographer quotes “I like to use a 
wide angle for my travel shots, and this picture is meant to represent 
journey’s end”  Andy Naylor
Photographic details: Camera: Nikon D200, Lens: Nikon 18-
70mm zoom, ISO: 200, Exposure: 1/160 @ F6.3. +0.3EV

Below: Glint photography always looks impressive, especially 
when the light starts to turn the subject area a little golden in 
colour. In the days of ‘proper’ Virgin Trains,  a Virgin HST forms a 
Northbound CrossCountry service, passing the former foot crossing 
(now footbridge) at sunset at North Stafford Junction, near Findern 
and Willington in Derbyshire. The illustration was taken on the 22 
December 2001. Phil Grain 
Photographic details: Camera: Mamiya 645 Pro TL, Lens: 
Mamiya 55-110 f4.5 zoom at 90mm, Film: Fuji Provia 
400F, Exposure: 1/1000 @ F5.6. Negative scanned on Epson 
Prefection 3200 scanner
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Described by the photographer as “non-enthusiast friendly”, the station at Hitchin is the location for this very unusual but well executed reflection 
picture, showing a Network South East liveried Class 365, reflected in the platform mirror. The exposure of an illustration such as this is critical, 
to ensure both the ‘real’ picture and the ‘reflection’ are of the correct density. Some work on illustrations such as this can be done in the electronic 
darkroom, by carefully selecting the reflection image and making separate adjustments to the remainder of the image area. The train caught is set 
No. 365529 forming the 12.20 Peterborough to London King’s Cross on 6 November 2006. Chris Nevard
Photographic details: Camera: Nikon D200, Lens: Nikon 28-70 f2.8 zoom at 48mm, ISO: 200, Exposure: 1/250 @ f7.1
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Above: A definite touch of ‘Photoshop’! Producing a railway 
image with a difference. In the photographer/artists own 
words “Firstly the original image file was loaded. Then using 
photoshop, I used the ‘Gradient Map’, selecting the ‘copper’ 
option, this gave the almost sepia effect across the whole 
image. The lens flare effect was relatively easy to achieve, by 
selecting one from a series of standard options on the ‘filter/ 
render’ menu. Once at this stage I saved the photo file as a 
new name so I still retained the original picture, but now have 
the modified image. I then opened both images, working on the 
original image first I used the magnetic lasso tool to select the 
EWS yellow band and yellow front end section, I then made 
a copy and pasted the area to the new image returning the 
colour. The result is certainly eye catching and is perhaps more 
of a work of art than a railway picture. The picture shows EWS 
Class 60 No. 60038 on an engineers train at Taunton on 24 
October 2004. Brian Garrett  
Photographic details: Camera: Canon EOS10D, Lens: 
Canon zoom at 28mm, ISO: 200, Exposure: 1/320 @ f9.5

Right: One of the strengths of the major preservation centres 
is that many allow special photographic evenings, where 
photographers can take the more unusual picture or experiment. 
Preserved Class 50 No. 50007 Sir Edward Elgar is seen 
lit only by moonlight at Swanwick Junction at the Midland 
Railway Centre. Mike Mccormack
Photographic details: Camera: Nikon D2X, Lens: Nikon 
28-70 f2.8 zoom. ISO: 400, Exposure: 30sec @ f5.6. Taken 
with mirror locked up, mounted on a Gitzo tripod and 
shot in raw then processed in Nikon Capture 4.4 and 
edited in Photoshop CS and converted to mono



Some photographers are always looking for that slightly different view. Here the established location of Horse Cove, Dawlish is shown from a more 
refreshing angle, looking back at the town and railway scape from the coastal footpath which runs between Dawlish and Teignmouth. One of the soon 
to be re-painted ex-Wessex Trains-liveried Class 150/2 units is seen pulling out of the tunnel, while the town of Dawlish can be seen in the background. 
Brian Garrett
Photographic details: Camera: Canon 5D, Lens: Canon zoom at 40mm, ISO: 200, Exposure: 1/640 @ F8


